Installing and Configuring Standalone (no 32kd) Console Systems


SECTION 1 – Overview and PC (configuration) Software installation

SAS consoles can operate as part of a large interconnected network of router resources, with one or two RIOs per console, each connected back to a 32kD frame via RioLink, sharing management functions and resources between all RIOs, input cards, output cards, and connected 32kD mainframes.  Systems surpassing 4000 input and 4000 output channels can be supported in this manner.  For smaller systems that do not need to share resources among all ins and outs, single or dual RIO console systems can operate independently with the same features and capabilities as 32kD based systems.  In plants where more than one of these “standalone” console systems are installed, shared sources are wired to each console system just like they were in legacy systems – paralleled or fed from distribution amplifiers.  
This document describes installation of Rubicon, RubiconSL, and M-Class console systems that are not integrated into a 32KD system.

Where a 32kD system is not available to integrate multiple RIOs into a single system, the RIOs act as mini-32kD frames.  There are two basic flavors of RIO standalone console systems: Single RIO and Dual-RIO.  In a single RIO console system, one console (or potentially two small, simple consoles) connects to one RIO – all of its audio ins and outs, optos, relays, and control ports are provided by the RIO.
In a Dual-Rio system two RIOs are connected together using a Cat5 crossover cable (or fiber option for longer than 100m cable distances between RIOs) connected to each unit’s RIO CAT5 port.  One RIO is the primary unit and one is the expansion unit.  The only physical difference between the two is a programming jumper on the expansion RIO.  Dual RIO systems can support two consoles (potentially more if the consoles are small/simple) or one console with additional ins and outs.  The primary RIO is typically installed in the same room as the console to minimize room to room wiring; while the expansion RIO can either be in the same location or some other location – another console’s room or a centralized wiring area / rack-room.  Each RIO’s sources, optos and relays are available on the other RIO.

SINGLE RIO CONSOLE SYSTEMS

The simplest installation is a single console on a single RIO.  All of the console’s ins and outs are provided by the RIO.  The RIO is also connected (full-time or as needed) to a Router Control PC for configuration/management and/or to facilitate PC-based SAS automation functions which we will get into later.  Multiple RIOs (and therefore consoles) can be connected to the same Router Control PC; the software’s architecture makes it easy to organize and manage the independent RIOs’ configurations.
The Router Control PC

The router control PC can manage multiple systems, small or large, by having multiple RS232 or TCP/IP connections - one to each RIO (or Frame for 32kD-based systems).  This PC should be a reasonably modern PC with at least one RS232 serial port.  We recommend a Windows XP (SP2) machine with a P4 or better, 1G or RAM, and at least 10 G of free hard-drive space.  If more than one RIO or 32kD will be connected, additional horsepower and memory are recommended.
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There are two main pieces of software that need to be installed on your router control PC for management and configuration: the Router Control Software, which is the user interface for configuring and managing all of the SAS resources in your plant; and the Server Module software, one of which is installed for each RIO in your plant.

The Server Module provides for serial or TCP/IP communication between the RIO and the Router Control Software.  If you have three single-RIO systems being managed by the Router Control Software, you will have one instance of the Router Control Software and three instances of the Server Module Software installed on your Router Control PC.  
RS232 Serial Connection

A straight-through db-9 serial cable (only pins 2,3, and 5 matter) connects the RIO’s back-panel DB9M connector (labeled J1702 RS232 port A) to an available COM port on the Router Control PC.  If you want to eventually use the TCP/IP method of communication between the RIO and the Router Control PC, you have to start out with a serial connection (so you can get into the RIO config and set the IP address) then change to TCP/IP. 
Software Installation and SETUP
The server module coordinates multiple devices “talking” to the Router at one time, including our free SoftPanels and the Router Control Software - it also logs system events and allows for differing PC and Router hardware configurations.
The Router Control Software is the graphical system gateway that allows you to see everything happening in your system, directly control crosspoint routes, edit system, console, and module configurations, change source or destination attributes, and set up extremely powerful router automation events.

A large percentage of SAS customers that have a dedicated Router Control PC also have or install VPN access so that SAS can access the Router Control PC remotely when requested.  In this way we can help you with configuration changes, custom features, complicated automation events, or troubleshooting if you encounter a problem.  XP’s built-in Remote Desktop feature, or VNC programs like UltraVNC are excellent choices.

The following guide will describe the process of installing and setting up the Sever Module, RCS software, and Router Automation module for connection to your RIO(s).

Once these three main software pieces are installed, the guide will show you how to duplicate the server module application for multiple RIOs.
Pre-Installationtc "SAS Server Module Installation"
System requirements

IBM compatible PC with at least a Pentium 4 processor (1GHz or greater) 

At least 256 MB RAM. 512M recommended.

Minimum 100 MB available hard disk space.

Windows  2000 SP3 or XP SP1 or higher operating system.

RS-232 connection to the SAS Routing Switcher (57600 Baud).

Network adapter card communicating on a network.

Note:  It is recommended that the Computer running the Server Module have a fixed IP address if the Router Control Software or Softpanels will be run on a remote computer.
Note:  If Windows 2000 is used, AT LEAST Service Pack 3 for Windows 2000 must be installed.

SAS Server Module
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Installation

CD:
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Insert the CD containing the SAS Server Module into the CD Drive.  Using Windows Explorer, go to the SAS Server Module directory on the CD and run setup.exe and follow the prompts on the screen.  
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Default choices are recommended.  If you have certain VB components on your Router Control PC, you may get one or more version conflict notices.  It’s no big deal, in the vast majority of cases, selecting yes for each notice is the right choice; this will keep your existing components instead of over-writing them. 

Getting Started

Once the Server Module has been installed make sure the first available COM port of the Router Control PC is connected to the RIO via the COM A (J1702) port on the RIO’s back panel.

Start the Server Module and select setup from the File menu.  Select the Serial Port that is connected to the RIO.  Set the IP Port number to 1250 for the first RIO, 1260 for the second, 1270 for the third, and so on.  Set the Router Type to “Rio Grande.”

If SAS Softpanels are to be used with the Server Module, click on the More button and check the Soft Panel Mode box.  

Once Ok is selected from the Setup screen “Switcher Connection” should appear in the Command History Window followed by several messages received from the SAS Switcher.

The SAS Server Module must be running and connected to the SAS Routing Switcher (RIO) in order to control the Switcher with SAS Windows RCS, SAS Automation engine or any SAS SoftPanels.  If the Server module is not running and connected to the RIO, no PC control or configuration of the RIO is possible.
SAS Windows Router Control 
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Software Installationtc "SAS Windows Router Control Software Installation"
System requirements

Same as IP Server Module

Installation

CD:

Insert the CD containing the SAS Windows Router Control Software into the CD Drive.  Using Windows Explorer, go to the SAS Windows RCS directory on the CD and run setup.exe and follow the prompts on the screen.
Getting Started

Once the Windows RCS has been installed make sure the SAS Server Module is running and connected to the Switcher.

Start the Windows RCS with the default user name and password.  Username is SASDefault
You will be prompted for the location and name of the Program Database.  It is recommended that this database be kept in the directory that the Windows RCS was installed in.  

This Program Database holds the location of the Switcher databases, Users, and Folder definitions.

It is recommended that you add a user to the user database, although the default user name and password may not be changed or deleted.  This can be done by selecting the View menu and then selecting User database or selecting Edit/View User Database from the toolbar.

The first time the Windows RCS is run, it will ask if you would like to define a switcher database.  Select Yes.

A switcher database will need to be created for each switcher to be controlled by the Windows RCS.  For now we’ll just set up the Switcher Database for the first RIO, the one you already installed the Server Module for.  Select the type of switcher (Rio Grand), size of the switcher (32 sources, 32 destination), the IP Address (use 127.0.0.1 - this is the “loopback IP” used for communications within the same computer) and IP Port of the Server Module (the IP Port must match that selected in the Setup Screen of the Server Module – 1250 for the first RIO).  Next click the file button [image: image17.png]Switcher Definition - [ 1 Records]
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 and enter a name for the Switcher database that uses the RIO identifier (be sure to append the name with .mdb), then click the Open button [image: image2.png]


.    Now click the Save button to exit the Switcher Definition screen.[image: image12.png]



Once the new Switcher definition is saved, you will be given the option of allowing the RCS to setup up default folders.  Select Ok.

The Windows RCS will create a set of default folders and attempt to connect to the Server Module.
Since we’re not quite done installing software components – exit the Router Control Software.  Then shut down the Server module you’ve already installed.

If your RCS installation will manage/configure more than one RIO, we’ll need to have a Server module running for each one before we can manage or connect to them.
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Use windows explorer to browse to the Program files folder on your main hard-drive.  Click once on the SAS Server Module folder to select it; hit CTRL-C to copy the folder .  then hit CTRL-V to paste a copy of the folder into the Program Files folder.  

Repeat the CTRL-V until you have the same number of Server Module folders as you have standalone RIOs.  The copied/pasted folders will probably show up at the bottom of your program files list (out of alphabetical order), 
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so find them and rename the copies and the original Server Module Folder to include a short RIO name or identifier. 
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Manually setting up the server modules.

Now open the first folder and find the file named tcpserve.ini.  Open tcpserve.ini with notepad.  The first few lines are all that you’ll want to change.

[CONFIGURATION]

Title=WGGG CR
Serial Port=1

Baud Rate=57600

TCP/IP Port=1250

Server Mode=Serial Mode

Switcher IP Address=127.0.0.1

Set Title to your RIO indentifier.  (like WGGG CR)
Set the serial port to the COM port number (on the PC) that connects to this RIO. 
The TCP/IP port should be 1250 for the first RIO, 1260 for the second, 1270 for the third…

Leave everything else the same.  Save the file.  

Right-click on the SasServer.exe file and select Send to > Desktop (create shortcut)
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On your desktop, change the name of the shortcut to indicate the RIO identifier.

Go back and repeat the Manually setting up the server modules instructions for each additional Server Module folder.
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Now that the Server Modules are preconfigured for the com port / RIO they’ll be talking to, we can start them up using the shortcuts you created on your desktop.  For now just start the first (COM1) Server Module.

It should look something like this but you should see plenty of data scrolling through the Command History display.  If the Command History display is blank, check your serial cable wiring.  You can also click on the File menu and select settings to verify the validity of the server module settings (Com port, router type, etc). 
If the Command History window shows data, go ahead and start the other server modules one at a time until they are all started and functioning properly.

Setting up additional Switcher Databases
Start the Router Control Software 
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The next step is to create switcher databases for any additional ROPs/server modules in your system.  Click on the View menu and select View Switcher Database.  

This familiar screen should pop up.
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Click the New button at bottom-center and enter the information for the next RIO/Server Module.
Identify the RIO being set up in the name field, set the number of sources to 32, the number of destinations to 32, the SAS Server IPPort to 1260 (or the next value you used) and set the switcher Type to SAS RIO Grand.  
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Click the File button.  Type in the filename for the mdb file to be created (in our example it would be something like WSKY CR RIO.mdb – then click Open.  Finally Click Save and Yes for creating default folders.  

Repeat creating new switcher databases until you have one for each RIO/server module, then press Quit to exit the View Switcher Database screen.

You can click on the little plus sign beside each RIO folder to show the contents of the folder.
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Your software installation is now complete!

Now that your RCS and Server Modules are set up and talking, it’s time to begin configuring your consoles.

The first step is to get the basic wiring done.  

The next two sections describe recommended wiring practices for Rubicon/RubiconSL consoles and MClass consoles respectively.

Section 1
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